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1. Purpose
This manual is a step-by-step guide to building a Peplink FusionHub server.

2. FusionHub License Generation

If you already have set up an InControl 2 account, please skip to step 5

1. To obtain FusionHub evaluation license information and download the FusionHub ISO
file from InControl 2, first sign in.

UNBREAKABLE

VPN

VPN THATREVER LETS YOU DOWN

LONG DISTANCE YOUR METWORK

ETHERNET y  ANYWHERE
CABLE

To sign in with Gmail, click Sign in with Google, choose your account, and then
grant InControl 2 permissions.
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To sign in without Gmail, click Login and enter your information. Next, click the link
found in your confirmation email. Return to the first screen to enter your username

and password.
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2. Once you successfully login, InControl 2 will prompt you to name your organization
and choose your language.

Create organization

Alan Tsui
Company

Language

— T

3. Name your group, choose a local time zone, and specify your location. Click Create
group to finish.

Important: Name your group

Group name: | Peplink FusionHub

This name identifies your group in Dashboard. It will also be used as the name for your first SSID.
Group time zone

Local time zone ‘ (UTC-12:00) International Date Line West
Address

Country

i United States [ ‘
Address United States Virgin Islands

| Map

v

\

Rhymer Hwy

Raphune Hii

sEsiport

’1of/,
7.
MapData TemsofUse Reportamap eror
Location | 18335765 -64.89633500!
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4. On the Add devices into groups dialog, click Cancel to skip this step and create the
group.

Add devices into groups

InControl 2 can check the warranty status of the following devices:
- Peplink Balance family

- Pepwave MAX family

- Pepwave Surf SOHO

For InControl 2 to manage a device, it needs to meet the following criteria:
- Device needs to be in warranty
- Device needs to run Firmware version 6.1

Serial numbers .92 XOOOL-XOOK-XXXX
(Comma. space or carriage
return separated)

Cancel

5. To obtain an evaluation license, navigate to Organization>Settings>Warranty &
License.

N
EEE Groups I!I-h Ocean Ventures
EEE

] Overview

Device Management

Create Group + Ocean Ventures

Group Management

Operation Log

Settings

Warranty & License
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Incont I‘OI {_Organization Level | Ocean Ventures Setiings > Warranty & License >
- " LLL}
;l Overview o Settings === Groups l!-h Ocean Ventures
Warranty Status
Filters:
ALL v Delete
Product Name Warranty Expiration Date Date of Sale
[ Peplink FusionHub 1234-ABCD-1234 (1234-ABCD-1234) 2014-04-07 2014-02-06
Pepwave MAX HD2 2345-BCDE-2345 (2345-BCDE-2345) 2014-05-22 2013-05-23
First | Previous E Next | Last E
5
o
w
FusionHub License Key Serial Number No. of Peers Max. Bandwidth (Mbps) License Type Expiry Date g
MHU987HG157S91D3 1234-ABCD-1234 2 50 EVALUATION 2014-04-07
1UQY98H58HGI06A3 3456-CDEF-3456 2 50 EVALUATION 2014-04-07
Import FusionHub License Import

S N S . Click to create a new evaluation license
&0“"’” A ECIick to download the latest FusionHub

To download the FusionHub, click the Download Latest FusionHub button located
below the Create Evaluation License button.
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7. InControl 2 will send the license information to the email address used to login. Follow
the steps in the email to add a virtual router using your FusionHub serial number.

8. To add FusionHub onto your organization, navigate to Organization>Settings>Add
Devices.

Add Devices
Device Management
+" Ocean Ventures

Create Group

Group Management

Operation Log

Settings

Warranty & License

© 2016 Peplink Page 6
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9. Enter the serial number from your license information email. Click Add devices and
continue your FusionHub installation.

Add devices into groups

InControl 2 can check the warranty status of the following devices:
- Peplink Balance family

- Pepwave MAX family

- Pepwave Surf SOHO

For InControl 2 to manage a device, it needs to meet the following criteria:
- Device needs to be in warranty
- Device needs to run Firmware version 6.1

Serial numbers: eqg
(Comma. space or carriage
return separated)

Add devices Cancel

© 2016 Peplink Page 7
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3. FusionHub Download

For all VM platforms besides Amazon Web Services, please download FusionHub from the
following link:

http://download.peplink.com/firmware/fusionhub/get

For Amazon Web Services, please refer to page 62 for instructions on how to download
and install.

4. FusionHub Deployment

This section will show how to implement FusionHub on VMware (ESXi server, Workstation,
Player), Oracle VirtualBox, Citrix XenCenter, Microsoft Hyper-V, and Amazon Web Services.
Please select your VM platform:

O YT T ST ) (T Y= /= 8
4.2 VMWare Workstation ...u.iuiieiieiiiiieiieiiiiiii s ss s s s s ss s s sa s s sa s asansansaneen 24
4.3 VMWAIE Player ... ccvuiiieiieieiie e s ee s e s s s s s e e s e s e s e s e s s e raa s s e nn e s e ran s e rnn s e ennneeennns 32
L O = Tol [T U= 1570 ) 42
Y 11 g D (=T 1 1T Y= 47
4.6 MICrOSOft HYPEI-V ..eeiiiei it e r e era e e ra s e nnas 54
4.7 AMAZON WED SEIVICES ..uivritnitiritiiniitiisiisiisisssssssssssssssssssasssnssssssnssnssnssnssnses 62

4.1 VMware ESXi Server

1. Download VMware ESXi 5.5.0 from_www.vimware.com/go/download-vsphere
and install it.

2. For VMware vSphere server installation hardware requirements, refer to
http:/ /www.vmware.com/products/vsphere-
hypervisor/gettingstarted.html

3. Open VMware vSphere. Enter the appropriate IP address / Name, User name,
and Password. Click Login to login to the ESXi server. Make sure that your
computer and ESXi server are on the same network. If your computer and ESXi
server are not on the same network, you won't be able to connect to FusionHub’s Web
admin interface, even though you can remotely access the ESXi server through a
router. Follow the steps found in 4 FusionHub Interface Configuration to connect
to FusionHub’s Web admin interface.

© 2016 Peplink Page 8
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) VMware vSphere Clien

vmware

VMware vSphere”
Client

@ In vSphere 5.5, all new vSphere features are avaiable only
through the vSphere Web Client. The traditional vSphere Client
will continue to operate, supporting the same feature set as
vSphere 5.0, but not exposing any of the new features in
vSphere 5.5.

The vSphere Client is still used for the vSphere Update
Manager (VUM) and Host Client, along with a few solutions
(e.q. Site Recovery Manager).

To directly manage a single host, enter the IP address or host name.
To manage multiple hosts, enter the IP address or name of a
vCenter Server.

1P address / Name: [ ;]

User name: I

Password: |

™ Use Windows session credentials

Login Close Help

4. After successfully logging in, click Inventory. The remaining contents of this section
will cover deploying a FusionHub virtual machine to your ESXi server.

O B |8
Arwentory b

t’e fdit Veew [oventory Administestion Flug-ing Help

Ede Edt View lgventory Administeation Plug-ins Help
Bl |9 rome b g tventory » B toventory

) Semmary  Virtual Mackines | Resource Alocation  Performance ' Coofiguwration  Local Users & Groups . Events | Permissions

close tab X
What is a Host?
A host 1s a computer that uses virtuaitization software, such Virtas) Machine A
as ESX or ESX1. 10 run virtual machines. Hosts provide the r 5 !
CPU and memory resources that virtual machines use and ' AR
give virtual machines access 10 storage and network .
connectivity

© 2016 Peplink Page 9
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6. Click File > Deploy OVF Template... to deploy the FusionHub OVF template
downloaded from InControl 2. In order to deploy the OVF template successfully, please
make sure that your ESXi server supports virtual machine version 8, which runs on
VMware ESXi 5.5 and later.

File | Edit View leventory Administration Plugeins Help

New » L?:rv 13 {, Inventocy
ot L |

Report Ll locathost peplink.com VMware ESX), 5.1.0, 1065491 | Evaluation (Expired)
Browse VA Marketplace... bt ) Summary - Virtesl Machines ' Resource Allocabion ' Performance ' Configwration  Locel Users A Growps - Events - Permussions

What is a Host?

Exit

A host Is a computer that uses virtualization software, such v ’ '
as ESX or ESXI, 10 run virtual machineés. Hosts provide the U
CPU and memeory resources that virtual machines use and (ks

7. On the Source dialog of the Deploy OVF Template wizard, click Browse. Locate
the FusionHub.ova template file on your computer and click Next.

© 2016 Peplink Page 10
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r R
(&) Deploy OVF Template E‘m

Source
Select the source location.

Source

OVF Template Details
Name and Location
Disk Format

Ready to Complete
Deploy from & file or URL

IC:\FusionHub‘l,D\l'F‘,FusionHub.o\ta ;I Browse. ., I

Enter a URL to download and install the OVF padkage from the Internet, or
specify a location accessible from your computer, such as a local hard drive, a
network share, or a CD/DVD drive,

Help | = Back Mext = Cancel

BN

© 2016 Peplink Page 11
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8. On the Name and Location dialog, type a name or keep the default setting. Click
Next.

-
(5) Deplay OVF Template = B =

H Hame and Location
Specify a name and lecation for the deployed template

| Sourge Bame:
OV Termplate D bads F"""'H""
| Hame and Location

Deesk: Format

The name can contain up to 50 characters and it must be unigue within the mentory folder.

Ready fo Complebe

© 2016 Peplink Page 12
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9. Keep the default settings on the Disk Format dialog. Click Next.

(5 Deploy OVF Template = B =
Disk Format
In which format do you want to stone the virtual diges?
I —
Mame ard Location -
Dk B : Mvadable space (GE): | 583.7
Ready to Complete
&+ Thick Provision Lazy Zeroed
" Thick Prorvision Eager Teroed
" Thin Provision
LI < Back I Mt > I | Cancel I
£

© 2016 Peplink Page 13
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10.0n the Ready to Complete dialog, review the deployment settings. Click Finish to
complete the process and close the wizard.

r R
(&) Deploy OVF Template E‘E‘ﬂ

Ready to Complete
Are these the options you want to use?

?ﬁmglat& Details When you dick Finish, the deployment task will be started.
MName and Location Deployment settings:
Digk Format OVFfile: C:\FusionHub\0VF\FusionHub.ova
Ready to Complete Download size: 7L7MB
Size ondisk: 400.0 MB
MName: FusionHub
HostfCluster localhost.
Datastore: datastorel
Disk provisioning: Thick Provision Lazy Zeroed

I Power on after deployment

Help | = Back | Finish I Cancel |

Y.

11.0nce you have completed the steps above, a FusionHub virtual machine is created.

(&) Deployment Completed Successfully El'_lg

Deploying FusionHub

Completed Successfully

© 2016 Peplink Page 14
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12.Click FusionHub in the column on the left side of the dialog to select the virtual

machine. Click Edit virtual machine settings to begin adding an Ethernet adapter to
the FusionHub virtual machine.

File Ect View lInventory Adminmtration Plug-ins Help
B B QD rome » g tventory b B Inventory
mU O BGDERDP
= [ 108924 FussonHub
P (IS LPETLIN . Summary  Resource Aocation ' Performance - Events - Console | Permissions
& -
close tab [
What is a Virtual Machine?
A wirtual machine is a software computer that, like a
physical compuler, runs an operating system and
applications. An operating system instalied on a virtual
maching i called a guest operating system
Because every virtual machine s an isolated computing
environment, you ¢an use virtual machines as Jeskiop or
workstation environments, as testing environments, or to
consoliate server applications
Virtual machines run on hosts. The same host can run S -
many virtual machines k\‘/c
Basic Tasks
p Power on the virtual machine
» Edit virtual machine settings
"
. - v ’ -
Recent Tasks Name. Target o Status contains -[ Cler N
Name Target | Rates | Details Intigted by | Requested Rt Ti. | Sant Time Completed Time -
#) Oeploy OVF template B oes © Complaed S/11/2013 19540 §/11/2013 14:54:11 5/11/2013 14:54:20
¥) ODdletefie © Compland roct S/11/2013 14:52:03 $/11/2013 14:52:93 S/11/2013 14:52:03 .
¥) Deletefie O Completad roct 5/13/2013 14:52:00 5/13/2013 14:52:00 5/14/2013 14:52:00 @ M
Tasks roct

© 2016 Peplink Page 15
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13.Click Add, found under the Hardware tab on the FusionHub — Virtual Machine
Properties dialog.

b FusionHub - Virtusl Machine Properties L=l E s

—Memory Configuration
™ show Al Devices Add... = ‘
[ SS— 1011 GB— "‘ETW}'SIHI 1j ij
Hardware | Summary 512 GBH
B Mvemory 1024 M8 | A R for
@ crus 1 [N o
) Maximum recommended for best
& video card Video card 128GBH 4 performance: 8083 MB.
VMCI devi Restricted
- _"'Et fes " i 64 GE|Hg Default recommended for this
& Hard disk1 Virtual Disk 4 guest OS: 1GB.
Gl e Minimum recommended for this
16 aal < guest OS: 64 MB.
5 GB |
4GB\
2 &8 H
1 GE |-
512 MB-
256 MiB -
125 MiE
64 ME ]
32 MBl-
16 MiE =
8MB -
4mpL
_ b | ox P
V"
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14.0n the Add Hardware dialog, select Ethernet Adapter. Click Next.

) Add Hardware - [y (oo

Device Type
What sort of device do you wish to add to your virtual machine?

Device Type Choose the type of device you wish to add.
Network connection

Ready to Complete

Information
This device can be added to this Virtual Machine.

) UsB Controller

a USB Device (unavailable)
[ o1 Device

| Ethernet Adapter

L -

QSCSI Device (unavailable)

Help I < Back “ Next > I Cancel

© 2016 Peplink Page 17
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15.0n the Network Type dialog, select VMXNET 3 as the Adapter Type. Select the
appropriate network and port settings from the drop-down menus under Network
Connection.

16.Check Connect at power on to connect the NIC when the virtual machine is powered
on.

17.Click Next.

[ £dd Hardware i S5

Network Type
What type of network do you want to add?

Device Type — Adapter Type
Network connection Type: -
Ready to Complete
M Adapter choice can affect both networking performance and migration compatibility.

Consultthe VMware KnowledgeBase formoreinformation on choosing among the
network adapters supportedfor various guest operating systems and hosts.

— Metwork Connection
Metwork label:

IInternet ;I

Port: M/fA

—Device Status

W Connectat power on

Help | % Back | Mext = I Cancel

A

© 2016 Peplink Page 18
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18.0n the Ready to Complete dialog, review your settings and click Finish.

peplink

-
(&) Add Hardware

[

Ready to Complete

Review the selected options and dick Finish to add the hardware.

Device Type Options:

MNetwork connection

Ready to Complete Hardware type: Ethernet Adapter
Adapter type: VMEMET 3
Metwork Connection:  Internet
Connect at power on: Yes

Help |

< Back

| Finish I Cancel

A

© 2016 Peplink
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19.Click OK to finish adding hardware.

. R
(&) FusionHub - Virtual Machine Properties E@g

Hardware I[jpﬁons | Resources | Virtual Machine Version: 8
—Device Status
[~ Show Al Devices Add... | Remove | [T connected
Hardware | Summary | ¥ Connect at power on
Bl Memory 1024 MB
— Adapter Type
H - crus ! Ci t adapte VMEMNET 3
Video card Video card EIEEELE A
VMCI devi Restricted
= evice gstri R
=3 Hard disk1 Wirtual Disk I—
Ef New NIC (adding) Internet |
(& Automatic " Manual
—DirectPath I/O
Status: Inactive &3
To activate DirectPath If0, go to the Resources tab and
select Memory Settings to reserve all guest memary.
—Metwork Connection
Metwork label:
Internet LI

Help | 0K Cancel |

© 2016 Peplink Page 20
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20.Click Power on the virtual machine to run FusionHub.

Eile Edt View lgventory Administraticn Blug-ms Help

ﬂ @) tome > ) toventory b Bl Swentory
Bl bR GDRERD P
Bﬁﬂ 108.9.24 FusionMub

3 Fusiontad Summary - ResowceAllocabion  Peformance  Evests  Console  Permissions

t close 1ab (2

What Is a Virtual Machine?

A virtual machine is a software computer that, ike a Virtsal Machines o [ )
physical computér, runs an operating system and

appications. An operating system Instaied on a virtual

machine is calied a guest operating system

Because every virtual machine s an isolated computing
environment. you can use virtual machines as deskiop or
workstation environments, as testing environments, or 1o
consohdate server applcations

Virtual machines run on hosts. The same host can run
many virtual machines

Basic Tasks
P Power on the virtual machine

& Edit virtual machine settings

Name. Taeget or Status cortmirs. « Clear

[ Toeget | Status | Details | Tnitiated by | Reauested art Ti. < | art Time | Completed Time ]
@ Complead rooct 5/11/2013 14:58:18 $/11/2013 t4:58:18 $/11/2013 14:58:18
¥) Deploy OvFtempinte © Completed S/314/2013 14:54:11 S/14/2013 14:54:11
#) Deletefie © Completsd 5/11/2013 14:52:03 S/14/2013 14:52:03 S/11/2013 14:52:03

9 Tasks [Evanation Mode Expued [T
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21.When the FusionHub virtual machine is powered on, right-click FusionHub. Select
Open Console for general information about FusionHub, including:

e FusionHub version

e System information

e Network settings:
Method: DHCP
IP Address: None
Admin: http://169.254.254.254

r’_, Fusignbub on localhost localdomain =) i_'H
File WView YM
BNy & E 3 g & 8 I

'eplink FusionHub G.1.8 build 1175

sustern Inforsation
! Hot found

. settings

i DHEP

P Address ! Hone
AdMin : http:r7169. 254, 254, 25¢

zsetup to configure network =ze

© 2016 Peplink Page 22
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22.The default WAN connection method is DHCP. If the DHCP server is available on your
network, the FusionHub IP address will be automatically obtained by the DHCP server.
In this case, the console will look similar to the following:

r -

(&) FusionHub on kcathostiocaldomain — S|
file View WM
BNy @B e

‘eplink FusionHub 6.1.8 build 1175

wstem Information
.icense : Not found

¢ settings
: DHCP
IP Address @ 18.8.8.2
subnet Mask: 255.2
ateway : 18.8.8.

> server | 18.8.8.
idMin : httpis/

nter '.l‘1l|}|. to conf iuurn- network settings

Please navigate to FusionHub Interface Configuration to continue your installation.

© 2016 Peplink Page 23
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4.2 VMware Workstation

1. Click FusionHub in the column on the left side of the dialog to select the virtual
machine. Click Edit virtual machine settings to begin adding an Ethernet adapter to
the FusionHub virtual machine.

2. Download VMware Workstation 10 from
http://www.vmware.com/products/workstation/ and install it. For VMware
Workstation installation hardware requirements, refer to
http://pubs.vmware.com/workstation-
10/index.jsp?topic=%2Fcom.vmware.ws.using.doc%2FGUID-55FF3F07-6 C2E-41F7-
B361-C7D870BCC4D7.html

3. Open VMware Workstation and deploy the OVF template.

4. Click File > Open to open the FusionHub.ova template downloaded from InControl 2.

[Bie] Bt Yew VM Tobs Hep
!5 New Virtual Machine... CirdeN l 0 -
7Sl New Window
Open... _Clﬂ'o’
Close Tab Ctrle W

e e maey . rkstation 10

Export to OVF
Map Virtual Disks...
] Connect to a Remote Server
- s ¥ Vi d rtual b
Create a New Virtual Machine I u-;ww::“:::age I

Virtualize a Physical Machine
I e Convert your PC to a virtual machine.
Open a Virtual Machine ™y Software Updates
- { @ Check for software updates to VMware
- . Workstation.
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5. On the Store the new Virtual Machine dialog, type a name for the new virtual machine
(i.e., FusionHub) and select the storage path. Please note that the storage path for this

FusionHub virtual machine should not be the same as for the downloaded FusionHub
OVF template file. Click Import.

.
Import Virtual Machine ﬁ

Store the new Virtual Machine

Provide a name and local storage path for the new
virtual machine.

-

Mame for the new virtual machine:

FusionHub

Storage path far the new virtual machine:

C:Wsers\Admin\Documents\Wirtual Machines\Fusi
e ) ()

6. After successful import, a FusionHub virtual machine is created.

= sl My Computer
(3 FusionHub
&7 Shared VMs

7. Click FusionHub in the column on the left side of the dialog to select the virtual
machine. Click Edit virtual machine settings to begin adding an Ethernet adapter.

Fde Ede Yiew VM Tabs Hep

| 2 VO IDa=X gl D
Library x
= w8 My Competer (. FusionHub

= Fusiont
SSnsreEr

o Home ¥ mlMyComputer X [ FusionMub *

¥ Devices
W Memory 168
[ Processors 1
S Had Disk I0E)  12M8
#)CO/OVD(DE)  Using file Fusion...
{4 Floppy Using drive &:
M Oisplay 1 monor

irtual Machine Details
State: Powered off
Configuration file: C:\Users\Tracy Lin\Documents!\Vietusl
Machanes\FusionHub\ FusionHub.vm
Hardware compatibility: Workstation 8.0 vitual machine

* Description - Virt

Ib
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peplink

8. Click Add, found under the Hardware tab on the Virtual Machine Settings dialog.

Memary
Specify the amount of memory allocated to this virtual

16 GB
BGE
4 GB
2GE
1GE

machine, The memory size must be a multiple of 4MB.
[ Processars 1 )
=i Hard Disk (IDE) 12M8 Memary for this virtual machine: 1024 = mMB
W Display 1 monitor :

& GEB

32GE

Maximum recommended memory

{Memory swapping may
ocour beyond this size.)

5948 MB

512 MB
256 MB
256 MB
128 ME
&4 ME O Guest OS5 recommended minimum
2 ME

32ZMB

16 ME
& ME
4 MB
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9. On the Add Hardware Wizard dialog, select Network Adapter. Click Next.

i Y
Add Hardware Wizard [

Hardware Type
What type of hardware do you want to install?

Hardware types: Explanation

et Hard Disk Add a network adapter,

#)CD/OVD Drive

E Flopow Drive

A Network Adapter |
USE Controller

#)) s0und card

E Parallel Port

Serial Port

@Printer

Generic SCSI Device

< Back I Next = I[ Cancel

10.0n the Network Adapter Type dialog, select Bridged: Connected directly to the physical
network and Replicate physical network connection state. Check Connect at power on
and click Finish.

Add Hardware Wizard ﬁ

Network Adapter Type
What type of network adapter do you want to add?

Metwork connection

@) Bridged: Connected drectly to the physical network
[¥| Replicate physical network connection state]

() MAT: Used to share the host's IP address

() Host-only: A private network shared with the host

() Custom: Spedfic virtual network

VMnetD (Auto-bridging) -

1 Device status
[¥] Connect at power gn

[ <Back |[ Fmsh ][ cancel

11.Click Configure Adapters to select the host adapter. This will apply only if you have
more than one network adapter. Otherwise, skip this step.
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Device status
% Memory 1GB Connected
[ Processors 1 [V] Connect at power on
mHard Disk (IDE)  12M8 '
#)COPVD (IDE)  Using file FusionHub-fle L.iso HSheacoecton
(= Floppy Using drive A: © Bridged: Connected directly to the physical network
E@Network Adapter  Bridged (Automatic) [V Replicate physical network connection state; '
Displa 1 monitor
- i Configure Adapters

(") NAT: Used to share the host's IP address
() Host-only: A private network shared with the host
‘ () Custom: Spedific virtual network

VWMnet0 (Auto-bridging) v
(7) LAN segment:

[LAN Segments... | | Adyanced... |

(o ][ cacel [ Heo |

12.When the Automatic Bridging Settings dialog opens, select the host network
adapter you want to automatically bridge and click OK.

Automatic Bridging Settings M

Select the host network adapter(s) you want to automatically bridge:

[~ IMicrosoft Virtual WiFi Miniport Adapter - VirtualBox Bridged Networking Driver Miniport:
[~ pell wireless 1506 802. 11b/a/n (2.4GHz) - VirtualBox Bridged Networking Driver Miniport
VirtualBox Host-Only Ethernet Adapter

Realtek PCIe GBE Family Controller - VirtualBox Bridged Networking Driver Miniport

(o J[ cancel J[ heb |
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13.Click OK to finish adding hardware.

Virtual Machine Setings T oS

| Hardware CD;B]

Device Summary Device status
‘ 5 Memory 1GB - Connected
[ Processors 1 [V] Connect at power on
& Hard Disk (IDE) 12M8
Té@network Adapter  Bridged (Automatic) Network connecion
B Display 1 monitor @ Bridged: Connected directly to the physical network

[V]Replicate physical network connection state’

() NAT: Used to share the host's IP address
() Host-only: A private network shared with the host
() Custom: Spedfic virtual network

VMnet0 (Auto-bridging) v

ok J[ cancel ][ reb ]
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14.Click Power on this virtual machine to run FusionHub.

file Edt  View VM Jabs Hep
Uibeary x

Q Type here to search -

£ My Computer
& Shared VMs

L FusionHub

P Power on this virtual machine

e K‘H wirtual machane sett ngs

(3 Upgrade this virtual machine

v Devices
M Memory 1G8

[ Processors 1
i Hard Disk (IDE) 12 MB

4 CD/DVD (IDE) Using file Fusion_.
{3 Floppy Using drive A:
¥ Network Adapter  Bridged (Autom...
B Display 1 monitor

v Virtual Machine Details
v Description State: Powered off
Type here to enter a description of Configuration file: C:\Users\Tracy Lin\Documents\Virtual
Machanes\FusicaHub\FusionkHub.vmux
Hardware compatibility: Workstation 8.0 virtual machine

tual machsne
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15.The FusionHub console opens automatically and displays the following general
information about FusionHub:

e FusionHub version

e System information

e Network settings:
Method: DHCP
IP Address: None
Admin: http://169.254.254.254

Peplink FusionHub 6.1.8 build 1175

3 4 Information
License : Hot fouwnd

Netuwork settings

et hoo ;. DHCP

IP Address : NHone

Adrin i http:-7169.254. 254 . 2¢

Enter 'setup’ to configure network settings
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16.The default WAN connection method is DHCP. If the DHCP server is available on your
network, the IP address of FusionHub will be automatically obtained by DHCP server.
In this case, the console will look similar to the following:

Peplink FusionHub 6.1.8 build 1175

Gustem Information
: Hot found

ork settings

- 1H 3. 1
: http:~~18.8.8. 252

xr ‘setup’ to configure network settings

Please navigate to FusionHub Interface Configuration to continue your installation.
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4.3 VMware Player

1. Download VMware Player 6.0 from
https://my.vmware.com/web/vmware/free#desktop end user computin
/vmware player/6 0 and install it.

Open VMware Player and install FusionHub.

Click Open a Virtual Machine to import the FusionHub.ova template downloaded
from InControl 2.

wnN

Welcome to VMware Player

\% Create a New Virtual Machine
y

. k2! Create a new virtual machine, which will then be
\\'b added to the top of your library.

Open a Virtual Machine

Open an existing virtual machine, which will then be
added to the top of your library. J

Upgrade to VMware Workstation

Get advanced features such as snapshots,
developer tool ntegration, and more.

Help
View VMware Player's help contents,

This product is not icensed and is authorized for
non-commercial use only. For commercial use,
purchase a license. Buy now.
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4. On the Store the new Virtual Machine dialog, type a name for the new virtual machine
(i.e., FusionHub) and select the storage path. Please note that the storage path for this
FusionHub virtual machine should not be the same as that for the downloaded
FusionHub OVF template file. Click Import.

i A
Import Virtual Machine ﬁ

Store the new Virtual Machine

Provide a name and local storage path for the new
virtual machine.

Mame for the new virtual machine:

FusionHub

Storage path far the new virtual machine:
C:Wsers\Admin\Documents\Wirtual Machines\Fusi | Browse...

Help | Import || cCancel |

5. After successful import, a FusionHub virtual machine is created.

g

B FusionHub

© 2016 Peplink Page 34



FusionHub Installation Guide — Installation on VMware ESXi Server pep||nk

6. Click FusionHub in the column on the left side of the dialog to select the virtual
machine. Click Edit virtual machine settings to begin adding an Ethernet adapter to
the FusionHub virtual machine.

FusionHub

State: Powered Off
0S: Other
Version: Workstation 8.0 virtual machine
RAM: 1GB

P> Play virtual machine

'ﬂ? Edit virtual machine settings
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7. Click Add, found under the Hardware tab on the Virtual Machine Settings dialog.

Memary

Specify the amount of memory allocated to this virtual
machine. The memory size must be a multiple of 4 MB.

Memary for this virtual machine: 1'3'24::.H3

4GB
2 GB
15 GB
EGE < @ Maximum recommended memary
4GB (Memory swapping may
268 ocour beyond this size. )
168 - e
512 MB
256 MB
256 MB
128 MB
B ME O Guest OS5 recommended minimum
2 ME ] 32 MB

15 MB
BMB
4 MB

© 2016 Peplink Page 36



FusionHub Installation Guide — Installation on VMware ESXi Server pep||nk

8. On the Add Hardware Wizard dialog, select Network Adapter. Click Next.

F B
Add Hardware Wizard [

Hardware Type
What type of hardware do you want to install?

Hardware types: Explanation
=\ Hard Disk Add a network adapter.
(¥4 CDfOVD Drive
[ Fiooov Drive
Us8 Controller
l& Sound Card
[ paralel Port
(8 serial Port
[& Generic 551 Deviee

<Back | [ _Next> ][ Cancel |

9. On the Network Adapter Type dialog, select Bridged: Connected directly to the physical
network and Replicate physical network connection state. Check Connect at power on
and click Finish.

S

Add Hardware Wizard

Network Adapter Type
What type of network adapter do you want to add?

Network connection
(@) Bridged: Connected directly to the physical network

(") NAT: Used to share the host's IP address

(") Host-only: A private network shared with the host

Device stahis N

|[¥] Connect at power on

[<§ad<][msh][<:amel]'J

10.Click Configure Adapters to select the host network adapter.
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Device Summary Device status
9 Memory 168 Connected
[ Processors 1 [¥] Connect at power on
Hard Disk (IDE)  12M8
£)COPVD (IDE)  Using file Fusiontub-fle .iso Networkcomecton
& Floppy Using drive A: © Bridged: Connected directly to the physical network
Enetwork Adapter - Bridged (Automat) [7]Replcate physical network connection state]
Displa: 1 itor

- i e Configure Adapters

() NAT: Used to share the host's IP address

() Host-only: A private network shared with the host

‘ () Custom: Spedific virtual network
VMnet0 (Auto-bridging)
() LAN segment:
Ui segnens..
(o ][ caxel J[ heo ]

11.0n the Automatic Bridging Settings dialog, select the host network which you want
to automatically bridge. Click OK to finish adding hardware.

Automatic Bridging Settings &

Select the host network adapter(s) you want to automatically bridge:

[T Microsoft Virtual WiFi Miniport Adapter - VirtualBox Bridged Networking Driver Miniport:
[~ pell wireless 1506 802. 11b/a/n (2.4GHz) - VirtualBox Bridged Networking Driver Miniport
[ virtualBox Host-Only Ethernet Adapter

Realtek PCIe GBE Family Controller - VirtualBox Bridged Networking Driver Miniport

ok J[ coancel J[ reb |
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12.Click Play virtual machine to run FusionHub.

VMware Player (Non-commercial use only)
Elayer v > v :.:

&

FusionHub

State: Powered Off
0S: Other
Version: Workstation 8.0 virtual machine
RAM: 1GB

P> Play virtual machine

L’jﬂ Edit virtual machine settings
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13.The FusionHub console opens automatically and displays the following general
information about FusionHub:

e FusionHub version

e System information

e Network settings:
Method: DHCP
IP Address: None
Admin: http://169.254.254.254

Peplink FusionHub 6.1.8 build 1175

3 4 Information
License : Hot fouwnd

Netuwork settings

et hoo ;. DHCP

IP Address : NHone

Adrin i http:-7169.254. 254 . 2¢

Enter 'setup’ to configure network settings
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14.The default WAN connection method is DHCP. If the DHCP server is available on your
network, the FusionHub IP address will be automatically obtained by the DHCP server.
In this case, the console looks similar to the following:
Peplink FusionHub 6.1.8 build 1175

Gustem Information
: Hot found

ork settings

to configure network settings

Please navigate to FusionHub Interface Configuration to continue your installation.
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4.4 Oracle VirtualBox

1. Download VirtualBox from https://www.virtualbox.orqg/wiki/Downloads and
install it.

2. Open VirtualBox. Click New to create a virtual machine for FusionHub.

File Machine Help

e » P (TEE) © s
{ Settings Start Discard

Welcome to VirtualBox!

The left part of this window is a list of all virtual machines on your computer, The list is empty now because you
haven't created any virtual machines yet.

In order to create a new virtual machine, press the New button in the main r 'f N 5
“ tool bar located at the top of the window. - ) 2
4

¥

You can press the F1 key to get instant help, or visit www. virtualbox.org for
the latest information and news.
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3. On the Create Virtual Machine dialog, specify a Name for the virtual machine.
Select Linux from the Type drop-down menu. Select Other Linux (64-bit) from the
Version drop-down menu. Click Next to continue.

2 o

<) Create Virtual Machine

Name and operating system

Please choose a descriptive name for the new virtual machine and select the
type of operating system you intend to install on it. The name you choose will
be used throughout VirtualBox to identify this machine.

Name: FusionHub

Type: [Lnux v ]
Version: [Other Linux (64-bit) v ]

|Hide Descripton| [ Next | [ cancel |

4. Set the memory size to 1024MB. Click Next.

(2 oo

@ Create Virtual Machine

Memory size
Select the amount of memory (RAM) in megabytes to be allocated to the
virtual machine.

The recommended memory size is 512 MB,

Y “,,._,1024335;MB

4MB 8192 MB

[ dext || cancel
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5. Click Use an existing virtual hard drive file. Select the fusionhub.vimdk file
downloaded from InControl 2. Click Create to create a virtual machine.

r @ E; B
@ Create Virtual Machine

Hard drive

If you wish you can add a virtual hard drive to the new machine. You can
either create a new hard drive file or select one from the list or from another

location using the folder icon.

If you need a more complex storage set-up you can skip this step and make
the changes to the machine settings once the machine is created.

The recommended size of the hard drive iz 8.00 GB.

) Do not add a virtual hard drive
() Create a virtual hard drive now

@ Use an existing virtual hard drive file

fusionhub.vmdk (Mormal, 400.00 MB) | @

[ Create ][ Cancel l

© 2016 Peplink Page 44



FusionHub Installation Guide — Installation on VMware ESXi Server

peplink

6. Select the newly created FusionHub VM and click Settings.

e
h'? Cracle VM VirtualBox Manager

BT ™5)

Machine

_{}iﬁv

- New Settingsisca?'d

Help

( @, General

Mame: FusionHub
. Operating System: Other Linux (64-bit)

( m System

Base Memory:
Boot Order:
| Acceleration:

1024 MB
Floppy, CD/OVD, Hard Disk
VT-3/AMD-Y, Nested Paging, PAEMX

| Display
Video Memaory: 12 MB
Remote Desktop Server:  Disabled
y Video Capture: Dizabled

( Storage

Controller: IDE
IDE Primary Master:
. IbE Secondary Master:  [CD,/DVD] Empty

Manage the virtual machine settings

fusionhub.vmdk {Mormal, 400,00 MB)

Snapshots

»

El, Preview

m

7. On the FusionHub - Settings dialog, click Network. Select the Adapter 1 tab

. Click

Enable Network Adapter and select Bridged Adapter from the Attached to:
drop-down menu. Select a proper adapter from the Name drop-down menu. Click OK

to continue.

G FusionHub - Settings M
@ General ‘ Network
System -
@ sy :
Display A?§p&rl [ Adoptes 2 LAdapherg J prwi,
Storage E\Zl Enable Network Adapter
B susi R )
| @ Network | Name: [RealmkPCIeGBEFarrulycontroller v]
| @ “Serial Ports B> Advanced
& usB = .
[ Shared Folders
ok J[ concel J[ bep |
| .
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8. Select the FusionHub VM. Click Start to run FusionHub.

F B
%§ Oracle VM VirtualBox Manager Eﬂlﬂ

File Machine Help

iﬁéﬁ‘l

New Settings

E, General E, Preview ."_

Start D|scard

»

Name: FusionHub
| Operating System: Other Linux (64-bit)

( m System

Base Memory: 1024 MB
Boot Order: Floppy, CD/DVD, Hard Disk
L Acceleration:  VT-xfAMD-V, Nested Paging, PAE/NX

m

' Display
Video Memary: 12 MB
Remote Desktop Server: Disabled
L Video Capture: Disabled

( Storage

Controller: IDE
IDE Primary Master: fusionhub.vmdk (Mormal, 400.00 MB)
. IoE Secondary Master:  [CD/DVD] Empty | =

Start the selected virtual machines

Please navigate to FusionHub Interface Configuration to continue your installation.
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4.5 Citrix XenServer
1. Download and install the XenCenter installer from your XenCenter server.

W l i i XenServer6.2.0 + i

€ @ 1083214
Citrix Systems, Inc. XenServer 6.2.0

XenCenter CD image

'XenCenter installer]

2. Open XenCenter. Click ADD a server.

© XerCenter nd - RNy
| Bl Yew Pool Sevwr VM Sgage Teveltm Tech Medow Hep

© moct + Q) Fonwnd [ 484 New Server BEC Mew Peot Mew Scesge NewyM | (@) St Down () fiebeet ([ Scapend Vuosf\lmAkm
Vews SV | © XenCenter

eqret D | Home |Sesech ; Tags l Legs
oz s
Citrix XenServer
Industry leading, open source platform for doud, server and desktop virtualization

— )
e . &
\/ ‘:‘[—' K" _"/ )

LEARN UPGRADE TRY
about usng XenServer Desktop

XerCenter Virtualization

Community Support Partners

* Network with other XenServer users
+ Vit the Canx Xnowledge Center
+ Learn more about partner offermgs
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3. On the Add New Server dialog, enter the appropriate Server IP address/name, User
name, and Password. Click Add to add the XenServer.

€) Add New Server T L9 [

Enter the host name or IP address of the server you want to add
and your user login credentials for that server.

Server: 10.8.8.244 -

User login credentials

User name: root

Password: ooooooool

]

[ Add ][ Cancel ]
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4. Enable E1000 gigabit device emulation in Citrix XenServer to take advantage of
FusionHub’s support for E1000 gigabit devices. For details, please refer to:
http://www.netservers.co.uk/articles/open-source-howtos/citrix e1000 gigabit

5. Right-click the XenServer and select Import to begin importing the OVA file to this

XenServer.
”
o XenCenter
File  View Pool Server WM Storage  Templates Tools
a Back - O Forward - @ Add Mew Server MNew Pool
Views: ISEWEI View "] E xenserver
|:Tfur':r'1... .O| General
= ﬁ HenCenter -
Server General Prope
o BB .
B ¢ New VM...
6§ {i3 MNewSR. Hies
) I‘| Import... |l
[} al
@ ! Add to Pool »
@ L Enter Maintenance Mode...
@ L tion:
% i @ Reboot
% L @ Shut Down
L
L Restart Toolstack
% F Disconnect :
B 4 Reconnect As... D:
B ¢ o
B ¢ Properties stination:
Server uptime:
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6. On the Import dialog, select the FusionHub.ova file downloaded from InControl 2.

F R
€3 Import El_lg

ﬁ Locate the file you want to import e

Enter the pathname of an exported VM or template, an OVF/OVA package or a virtual hard disk image file

or click Browse to find the file you want.

Location

Storage - -
Filename: Ch\FusienHub\OVF\FusionHub.ova

Metworking
Finish

ciTRIX

< Previous Mext > ] [ Cancel
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7. Click Next to keep the default settings and display the Configure networking
options for the Transfer VM dialog. Select an appropriate network on which the

temporary VM used to perform the import operation will run. Click Next. Click Finish
to import the OVF file.

€3 Import OVF/OVA Package— — e — W . ® - - —-— -

@ Configure networking options for the Transfer VM

Import Source Select the network on which the temporary VM (Transfer VM) used to perform the import operation will run.
EULAs
Location Nef k. |N k0 ( 9 ) Dt
Storage
_ Network Settings
Networking .
. @ Automatically obtain network settings using DHCP
Security
. . () Use these network settings:
OS Fixup Settings
Transfer VM Settings [P address:
Finish Subnet mask:
Gateway:

ciTRIX'

[ < Previous ] [ Next > ] [ Cancel

8. Click FusionHub -> Networking -> Add Interface to add a network interface.

File View Pool Sever VM Storage Templates Tools Window Help
Q@ Bock - () Forvard - | [ AddNewSewver | B NewPool T NewStorage T NewvM | (@) Start () Reboot () Suspend 8 NoSystem Alerts
Views: | Server View v B on ' 5 Logged in as: Local root account
Scorch.. £ | General | Memori] Storage | ing | Cansole | | [ Logs
= € XenCenter [ —
= [ xenserver-FusionHub
W OVOdmes DVDDrivel: fusionhub-620-build1219.is0 [ gieer
g Local storage <empty>
i LocallsO Posttion  DVD drives on xenserver-FusionHub o
9 Removable storage o 0 2 A; 2 b IL g
fusionhub-6.20-build1 21950 |
Rewdewver toms
xs-tools.iso
'
Add.. | [ AttachDisk.. ||| Activate Move.. Properties | | Delete Detach

8. Click FusionHub -> Networking -> Add Interface to add a network interface.
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File View Pool Sever VM Storage Templates Tools
Q) Back - Q) Forvard - @AddNewsmu EE NewPool T New storage T NewvM | (@) start (3 Reboot ([} Suspend off NoSystem Alerts |
Views: | Server View B FusionHub on ‘xenserver-FusionHub’ Logged in as: Local root account

0 le]Pedummu[Smpshou[Logx ‘

Window  Help

Virtual Network ]mevf

S — Networks

8 Local storage Device ~ MAC Limit Network IP Address Active
il LocallSO

fil Removable storage

9. On the Add Virtual Interface dialog, select the network and click Add.

€ Add Virtual Interface , L2 i)

Select your network and MAC address for this virtual interface.
You can also optionally define a QoS limit.

Network: | Network 0 'J

MAC address:
@ Auto-generate a MAC address

(7) Use this MAC address: aa:bb:caddieeff

QoS settings:
"] Enable a QoS limit of: Kbytes/s

10.Click FusionHub -> Start to run this FusionHub virtual machine.
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€) XenCenter [ [ E i
| Eile View Pool Server VM Storage Templates Tools Window Help |
| @ Back - () Forvar 0 Add New Server | BE NewPool T New storage T New v | (@) start [§ end §f NoSystem Alerts
[ ;
| Views: | Server View v| [ Fusi on ' Logged in as: Local root account ‘
£ | General | Memory | storage Console | | [ Logs
= XenCentt
0:" e Virtual Network Interfaces
5 [ xenserver-FusionHub
L] Fusiontiub)
¥4 DVD drives Networks
&g Local storage Device ~ MAC Limt  Network [P Address Active
8 Locallso 5.0 feAbb2:bfAd:cd Network0  Unknown No
i Removable storage
[ﬁiq‘ lﬁeﬂgin;] Properties Remove Activate
= i

11.Click FusionHub -> Console to open the console.

VM Storage JTemplates Tools Window Help

Q Back - () Forvard @ Add New Sesver | (B] New Pool (T8 New Storage T New vM hut Down §#3 Reboot ([} Suspend

Eile View Pool Server

f NoSystem Alets _

Logged in as: Local root acd]

Views: [ Server View v/ g FusionHub on 'xenserver-FusionHub’

D General ‘ Memory \ Storage } Nemorkmg[(ﬂniﬂ't P élo(man(e Snapshets | Logs

= € XenCenter
i@ xenseqver-FusionHub
3
1 OVD drives
fig Local storage
@ LocallSO
i Removable storage

fusionhub-6.2.0-build1219.is0

system Information
Not found

1
1

0.8.9.8

conf igure network

Send Ctri+ Alts Del (Ctrls Alt+Insert) Scale | 27| Undock (Alt+Shift+U) | | | Fullssreen (Ctrlo€

Please navigate to FusionHub Interface Configuration to continue your installation.
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4.6 Microsoft Hyper-V

1. Open Hyper-V and install FusionHub, click New -> Virtual Machine to create a virtual
machine for FusionHub.

File Action View
| > o:

23 Hyper-V Manager || | Actions
g W|ND| Mew Virtual Machine...

Import Virtual Machine... Hard Disk...

Hyper-V Settings... Eloppy Disk...
Virtual Switch Manager...
Virtual SAMN Manager...

Hyper-V Settings...
Virtual Switch Manager...

b e [

Edit Disk... Virtual SAN Manager...

Inspect Disk... Edit Disk...

Stop Service

Inspect Disk...
Bemowve Server

Refresh

Stop Service

Remowve Server
View

W XO®ER

Refresh

Hel
== View

*!’. ] | Help

Displays the Mew Virtual Machine Wizard,
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2. On the Specify Name and Location dialog, specify a name for the virtual machine.
Click Next.

Specify Name and Location

Before You Begin Choose a name and location for this virtual machine,

Spedfy Name and Location The name is displayed in Hyper-¥ Manager. We recommend that you use a name that helps you easily

Spedfy Generation identify this virtual machine, such as the name of the guest operating system or workload.

Assign Memory Mame: |Fusior1Hub

Configure Networking You can create a folder or use an existing folder to store the virtual machine. If you don't select a
Connect Virtual Hard Disk folder, the virtual machine is stored in the default folder configured for this server.

Installation Options [] store the virtual machine in a different location

Summary Location: |C: \ProgramDataMicrosoft\Windows \Hyper-v | | Browse...

A If you plan to take checkpoints of this virtual machine, select a location that has enough free
space. Chedkpoints indude virtual machine data and may require a large amount of space.

< Previous | | Mext = | | Einish | | Cancel
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3. On the Specify Generation dialog, choose Generation 1. Click Next.

Specify Generation

Before You Begin Choose the generation of this virtual machine.
Spedfy Name and Location (® Generation 1

Spedify Generation This virtual machine generation provides the same virtual hardware to the virtual machine as in
e E— previous versions of Hyper-V.

Configure Networking (0 Generation 2

. This virtual machine generation provides suppart for features such as Secure Boot, SCSI boot, and
et b L PXE boot using a standard network adapter. Guest operating systems must be running at least
Installation Options Windows Server 2012 or 64-bit versions of Windows 8.

Summary & Once a virtual machine has been created, you cannot change its generation.

< Previous | | Mext = | | Finish | ‘ Cancel
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4. On the Assign Memory dialog, set the memory size to 1024MB. Click Next.

Before You Begin Specify the amount of memory to allocate to this virtual machine. You can specify an amount from 32
ME throuah 2528 ME. To improve performance, specify more than the minimum amount recommended
for the operating system,

Specify Generation e —— ME

Assign Memory
Configure Networking
Connect Virtual Hard Disk

Specify Mame and Location

[ Use Dynamic Memary for this virtual machine.

@ When you decide how much memary to assian to a virtual machine, consider how you intend to
use the virtual machine and the operating system that it will run.

Installation Options

summary

< Previous || MNext = || Einish || Cancel
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5. On the Configure Networking dialog, select a network adapter and click Next

-/ Configure Networking

Before You Begin Each new virtual machine indudes a network adapter. You can configure the network adapter to use a

wvirtual switch, or it can remain disconnected.
specify Mame and Location !

Specify Generation Connection: |Realtek PCle GBE Family Controller - Virtual Switch

Assign Memary

Configure Metworking

Connect Virtual Hard Disk
Installation Options

Summary

< Previous | ‘ Mext = | | Finish ‘ | Cancel
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6. On the Connect Virtual Hard Disk dialog, select "Use an existing virtual hard
disk” and select FusionHub.vhd from the location you downloaded FusionHub. Click Next.

i New Virtual Machine Wizard | x|
*; Connect Virtual Hard Disk
Before You Begin A virtual machine reguires storage so that you can install an operating system. You can spedfy the

storage now or configure it later by modifying the virtual machine’s properties.
Specify Mame and Location < d b fying FLEE

Spedfy Generation () Create a virtual hard disk

Use this option to create a VHDX dynamically expanding virtual hard disk.

Assign Memory

Configure Networking Mame:  |FusionHub,vhdx
Connect Virtual Hard Disk Location: |C:\Wsers\Public\Documents\Hyper-Vivirtual Hard Disks\, Browse
Summary

Size: 127 GB (Maximum: 64 TB)

(®) Use an existing virtual hard disk

Use this option to attach an existing virtual hard disk, either VHD or VHOX format.

Location: |L,I:‘lFusinnHub‘l,VHD‘lFusinnHub.vhd | | Browse...

() Attach a virtual hard disk later
Use this option to skip this step now and attach an existing virtual hard disk later,

< Previous H Mext = H Einish H Cancel
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7. Click Finish to complete virtual machine configuration.

Completing the New Virtual Machine Wizard

Before You Begin You have successfully completed the Mew Virtual Machine Wizard. You are about to create the

fallowing virtual machine.
Specify Name and Location R

Specify Generation Srlil

Assign Memory Mame: FusionHub

Generation: Generation 1

Memary: 1024 MB

Connect Virtual Hard Disk Metwork: Realtek PCIe GBE Family Controller - Virtual Switch

Summary Hard Disk:  C:'FusionHub\WHDFusionHub.vhd (VHD, dynamically expanding)

Configure Metworking

To create the virtual machine and dose the wizard, dick Finish,

« Previous | | Mext = | | Finish
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8. Click Start to to run this FusionHub virtual machine.

File Action View Help

«=| 7[5 0=

23 Hyper-V Manager
g WINDOWS-SERVER Virtual Machines

MName “ State CPU Usage

MNew
I FusionHub Off

Connect... e Import Virtual ...

Settings... ¥ Hyper-V Setting...

Start IL Virtual Switch ...

Checkpoint L] Vvirtual SAN Ma...

Maove.. Edit Disk...

Export... Inspect Disk...

Delete... Remove Server

2

Rename... :I) Stop Service
'
el

Enable Replication... Refresh

Help View

ﬂ Help
Created:  9/5/2014 44757 PM HilﬂiH"h -

Version: 5.0 Connect...
Generation: 1
Motes: MNone

FusionHub

=1 Settings...
Start
Checkpoint

Summary | Ma’norjrl Networking | Replication | = Move..

<| m | Export...

Starts the selected virtual machine.

Please navigate to FusionHub Interface Configuration to continue your installation.
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4.7 Amazon Web Services
Acquiring FusionHub for AWS

1. Currently, the only means to acquiring FusionHub for AWS is through private
sharing. You would need to provide the following information to trial@peplink.com.
Peplink will then share the AMI image to your account:

e InControl2 account username
e Amazon EC2 region (e.g. Oregon)
e 12-digit Amazon ID

2. Login to your AWS Management Console

3. Inthe left hand panel, expand “Images”, select “AMIs”.

4. Atthe top, locate “Filter:” and pick “Private images”.

5. Click on “Peplink FusionHub” to highlight it. A blue dot will appear to show that it is
currently highlighted.

6. Click on the “Launch” button at the top.

EC2 Dashboard - ) Actions «

Events

Tags Filter: Allimages ~  All platforms Q X

Reports

Limits Name ¥ ~ AMIName - AMIID ~ Source ~  Owner -~ Visibilit
=] INSTANCES B Peplink FusionHub 6.2.1b01 ami-fd3375¢cd 100871073111/... 100871073111 Private

Instances

Spot Requests
Reserved Instances

=| IMAGES

Bundle Tasks

ELASTIC BLOCK STORE

Setting the Instance type

1. In the next screen “Choose an Instance Type, click to highlight “t2.micro”
2. Then click “Configure Instance Details” at the bottom right of the page.
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1.Choose AMI 2. Choose Instance Type 3. Configure Instance 4. Add Storage 5. Tag Instance 6. Configure Security Group 7. Review

Step 2: Choose an Instance Type

Amazon EC2 provides a wide selection of instance types optimized to fit different use cases. Instances are virtual servers that can run applications. They have varying -
combinations of CPU. memory, storage, and networking capacity, and give you the flexibility to choose the appropriate mix of resources for your applications. Learn more about
instance types and how they can meet your computing needs.

Filter by: All instance types v Current generation ~  Show/Hide Columns

Currently selected: t2.micro (Variable ECUs, 1 vCPUs, 2.5 GHz, Intel Xeon Family, 1 GiB memory, EBS only)

il ” T " VCPUs :D o T (EE) < Instance S&))rage (GB) = E:’:::ill;ml(zf;d » Network P&r;ormance

General purpose 12.nano 1 0.5 EBS only - Low to Moderate
mele 1 1 EBS only - Low to Moderate

General purpose 12.small 1 2 EBS only - Low to Moderate

General purpose t2_medium 2 4 EBS only - Low to Moderate

General purpose. 12 large 2 8 EBS only - Low to Moderate

General purpose m4. large 2 8 EBS only Yes Moderate

General purpose m4 xlarge 4 16 EBS only Yes High

General purpose. m4_2xlarge & 32 EBS only Yes High

General purpose m4.4xlarge 16 64 EBS only Yes High -

Cancel | Previous Frev: and Launch Next: Configure Instance Details

Configuring the Instance
1. The “Configure Instance Details” page allows you to make changes to the Instance
details and network interfaces. If you’re unsure what these should be, then please
skip this step.

2. Click “Review and Launch” at the bottom right
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1. Choose AMI 2. Choose Instance Type 3. Configure Instance 4. Add Storage 5. Tag Instance 6. Configure Security Group 7. Review

Step 3: Configure Instance Details

Configure the instance to suit your requirements. You can launch multiple instances from the same AMI, request Spot Instances to take advantage of th

Number of instances (i) 1
Purchasing option (i) [ Request Spot Instances
Network (i) [ypc-2e4sacdb (172.31.0.0/16) (default) v||C Create new VPC
Subnet (i) | subnet-ca60Bcbe(172.31.16.0/20) | Default in us-we v | Create new subnet
4091 IP Addresses available
Auto-assign Public IP (i) | Use subnet setting (Enable) v|
IAMrole (i) [None "]
Shutdown behavior (j) | stop v
Enable termination protection (_i) [ Protect against accidental termination

Monitoring (i) [J Enable Cloudwatch detailed monitoring
Additional charges apply.

Tenancy (i) | Shared tenancy (multi-tenant hardware) v
Additional charges will apply for dedicated tenancy.

¥ Network interfaces

Device  Network Interface Subnet Primary IP Secondary IP addresses

ethd | New network interfact v | | subnet-cag0scbe v | Add 1P

3. In the next page “Review Instance Launch”, click on “Edit security groups”.

1. Choose AMI 2. Choose Instance Type 3 Configure Instance 4. Acd Storage 5. Tag Instance & Configure Security Group 7. Review

Step 7: Review Instance Launch

Please review your instance launch details. You can go back to edit changes for each section. Click Launch o assign a key pair 10 your instance and complete the launch process. -

Improve your instance's security. Your security group, launch-wizard-3, is open to the world.

Your instance may be accessible from any IP address. We recommend that you update your security group rules to allow access from known |P addresses only.
You can also open additional ports in your security group 1o facilitate access 1o the application or service you're running, e.g.. HTTP (80) for web servers. Edit security groups

* AMI Details Edit AMI

Peplink FusionHub 6_2.1b01 - ami-fd3375cd
Peplink FusionHub 6.2 1601

Fioot Device Type: ebs  Virswalization type: paravirual

* Instance Type Edit instance lype
Instance Type ECUs vCPUs Memory [GiB) Instance Storage (GB) EBS-Optimized Available HNetwork Performance
1.micro Wariable 1 0613 EBS only

~ Security Groups Edit security groups

Security group name launch-wizard-3
Description launch-wizard-3 created 2014-09-05711:47:15.229+08:00
Type (i Protocol (i Port Range (i Source (|
SSH TCR 22 0.0.0.00
¥ Instance Details Edit instance details &
» Storage Edit storage _

Cancel | Previous m

4. Configure the security group settings as follows:
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Remove SSH

Add TCP 2222/32015
Add UDP 4500

Add HTTP/HTTPS

5. Click “Review and Launch”

1. Choose AMI 2 Choose Instance Type 3. Configure Instance 4 Add Sorage 5. Tag Instance 6. Configure Security Group 7. Review

Step 6: Configure Security Group
A securnity group i 3 Sel of firewall rules that contrgd the trafic for your instance. On this page, you can add rules to allow specific traffic to reach your instance. For example, if you want 1o et up a web server and allow Intemnel traffic 1o reach your
instance, add rules that allow unrestricted access to the HTTP and HTTPS ports. You can create a new security group or select from an existing one below. Leamn more about Amazon EC2 security groups.

ASSign a security group: ® Create a new security group

Select an existing securily group

Security group name: launch-wizard-3
Description: launchwizard-3 croated 2014-09-05T11.48:41.983+08.00

; Brotocal Bost@angs Souceg (|

Custom TCP Rule TCP 2222
ke + 0000 (]
Custom TCP Rule  + TCP 32015 bre +| [00.0.010 a
Custom UDP Rule v uDP 4500 ere_* | 0.0.0.000 (=]
HTTPS v TCP 443 re_*| [0.0.0.00 L
HTTP v TCP 80 pre v | [D.0.0.00 (]
Add Rule
Warning

“You will not be abie to connect o this instance as the AMI requires port(s) 22 to be open in order to have access. Your current securfty group doesn't have pori(s) 22 open

Warning

Rules with source of 0.0.0.040 aliow all IP addresses to access your instance. We recommend setting security group rules to aliow access from known IP addresses only.

Review and Launch

6. Confirm that the details are correct, and then click “Launch”.

1.Choose AMI 2 Choose instance Type 3. Confgure Instance 4. Add Storage 5 Taginstance 6. Configure Secury Group 7. Review

Step 7: Review Instance Launch
Please review your instance launch details. You can go back to edit changes for each section. Click Launch 1o assign a key pair 1o your instance and complete the launch process. -
A Improve your instance’s security. Your security group, launch-wizard-3, is open to the world.

Your instance may be accessible from any IP address. We recommend that you update your security group rules 1o allow access from known IP addresses only.
You can also open additional ports in your secufity group o facitale access to the application of service you're running, e.g.. HTTP (80) for web servers. Edil securily groups

~ AMI Details Edit AMI
Peplink FusionHub 6.2.1b01 - ami-fd3375ed
(_\ Peplink FusionHub 6.2 1601

Rool Device Type: ebs  Virtuakzation type: paravinial

¥ |nstance Type Edit instance type
Instance Type ECUs VCPUs Memory (GIB} Instance Storage (GB) EBS-Cptimized Avallable Network Performance
t1.micro Variable 1 0613 EBS only - Wery Low
= Security Groups Edit security groups
Security group name launch-wizard-3
Description launch-wizard-3 created 2014-09-05T11:48:41 983+08.00
Type (i Pratocol (| Port Range (| Source (|
Custom TCP Rule TCP 2222 00000
Custom TCP Rule TCR 3205 0.0.0.0v0
Custom UDP Rule upe 4500 0.0.0.0v0
HTTPS Tep 443 0.0.0.00
HTTP TCP 80 0.0.0.0v0

Cancel P

Tweak the running Instance
1. Inthe left hand panel, expand “Instances” and click on “Instances”.
2. Select FusionHub’s running instance by clicking on it once.
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EC2 Dashboard ) ETNEEN I | Connect || Actions v

Events

Tags Q, Filter by tags and attributes or search by keyword

Reports

Limits Instance ID ~ Instance Type « Availability Zone ~ Instance State -~ Status Checks -~ Alarm Status Public DNS
=] INSTANCES E] i-20353328 t1.micro us-west-2¢c @ running & 2/2 checks ... None ‘m.- ec2-54-213-85-
| Instances

Spot Requests

Reserved Instances 1
=) IMAGES Instance: | i-20353328 Public DNS: ec2-54-213-85-222 us-west-2.compute.amazonaws.com
AMIs —
Bundle Tasks Description Status Checks Monitoring Tags
Instance ID  -20353328 Public DN:
&) ELASTIC BLOCK STORE Instance state  running Public Il
Volumes
Instance type  t1.micro Elastic Il

3. After highlighting the running instance, right-click to bring up the context menu.
4. Click on “Change Source/Des. Check” in the context menu

5. Select “Disable Source/Dest. Check”.
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FC2 Dashboard Connect  Actions v
Events \
Tags Q
Reports
Limits InstancelD - Instance Type =~ Availability Z
=l INSTANCES Instance Management Is-west-2c
l Instances Launch More Like This
Spot Requests Add/Edit Tags
Reserved Instances 4
— IMAGES | Create Image c2-54-213-8
AMIs - - _
Bundie Taske Change Termination Protection itoring
View/Change User Data 3398
=] ELASTIC BLOCK STORE Change Shutdown Behavior
Volumes °
Snapshots Get System Log 21-]’—99.%-\.
=) NETWORK & SECURITY Networking 1.7.99
Security Groups Change Secunty Groups
i Attach Metwork Interface
Elastic IPs 48acdb
Placement Groups
Load Balancers I _ - cfeBc789
Key Pairs Manage Private |P Addresses

Network Interfaces

Actions

=| AUTO SCALING Terminate

I annch Cnnfinnratinnes
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Accessing FusionHub

1. Note down FusionHub’s public IP address.

(2] 1to 2 of 2
Jlarm Status Public DNS = | Public IP - | Key
'one Y&  ec2-54-213-85-2 us-west-2.compute.amazonaws.com 54213852 solr
N

Public DNS  ec2-54-213-85-2 us-west-2.compute.amazonaws.com
Public IP
Elastic IP -
Availability zone  us-west-2c
Security groups  launch-wizard-2 . view rules

Scheduled events Mo scheduled events

FE T TET N Fal an L B T ' e oa TN

2. In your web browser, type in “http://[FusionHub.instance.public.ip.address]” in
order to access FusionHub’s administration interface. In our example, the line to
type into the web browser would be: http://54.213.85.2/

3. Follow Section 5 to continue.
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5. FusionHub Interface Configuration

5.1 Connecting to FusionHub’s Web Admin Interface

1.

2.

Open a Web browser on the computer hosting your Peplink FusionHub virtual machine.

To access FusionHub’s Web admin interface, connect your computer to the network on
which FusionHub is running. The default WAN connection method for FusionHub is
DHCP.

If the DHCP server is available in your network, the FusionHub IP address will be
automatically obtained by the DHCP server. The Web admin address will appear on the
FusionHub console automatically (i.e., Admin: http://10.8.8.252). Enter the Web admin
address (i.e., http://10.8.8.252) in your Web browser's address field.

If there is no DHCP server in your network, set your computer’s IP address to
169.254.x.x (x denotes any integer from 2 to 253), using a subnet mask of
255.255.0.0.

After successfully changing these settings, enter http://169.254.254.254 in your
Web browser’s address field.

Next, access the Web admin interface by entering admin for both the user name and
password. The default admin and read-only user passwords can be changed after
logging into the Web admin interface at System > Admin Security.

e®°
l pholoc'.ng Business Condinulty We b Ad m l n
Login
Usemame
l
Password
Logn
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7. Once you have successfully logged in, the Setup Wizard will be displayed.

Dashboard Setup Wizard Network System  Status

Setup Wizard > Welcome > Step 1

Welcome 1o Setup Wizard!

The Setup Waard wil gude you through the port(s) configuration step by step. Thes wizard 15 designed to
smphfy the process n configunng your device and connectng it to the Intemet.

Chck Next to begn

Noxt >> Cancel

5.2 Configuration Using the Setup Wizard

FusionHub’s Setup Wizard leads you step-by-step through the process of configuring
your WAN connection.

1. Click Setup Wizard after connecting to the Web admin interface.

Dashboard | Setup Wizard |Network System Status

2. Click Next to begin.

Setup Wizard > Welcome > Step 1

Welcome to Setup Wizard!

The Setup Wzard will gusde you through the port(s) configuration step by step. This wzard is designed to
simpify the process in configuring your device and connecting it to the Intemat.

Chick Next to begn.
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3. Click Next to configure the WAN connection. Select the WAN connection method from
the following screen. The default selection is DHCP.

Choose a connection method for WAN port

Static

DHCP
PPPOE

4. Depending on the selected connection type, further configuration may be needed:

o If Static is selected, the Setup Wizard will display Static IP Settings.

Enter the parameters of Static IP setting for WAN port

Static IP Settings

'IP Address
Subnet Mask | 255.255.255.0 [+]

Gateway

DNS Servers DNS Server 1: |
DNS Server 2:

o If DHCP is selected, the Setup Wizard will display DHCP Settings.

Enter the parameters of DHCP setting for this port

DHCP Settings

DNS Servers ¢ Obtain DNS server address automatically
Use following DNS server address(es)

DNS Server 1:
DNS Server 2:

Client ID (Optional): I
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o If PPPOE is selected, the Setup Wizard will display PPPOE Settings.

PPPOE Settings @

Obtain DNS server address automatically
9 Use following DNS server address(es)

DNS Server 1:
DNS Server 2:

During this step, make sure the FusionHub and ESXi servers are on the same network if
Static is selected. For example:

If the ESXi server’s IP settings are:
IP address: 10.8.9.124

Subnet mask: 255.255.0.0
Default gateway: 10.8.8.1

Configure port settings as follows:

IP address: 10.8.x.x (x denotes any integer from 2 to 254)
Subnet mask: 255.255.0.0

Default gateway: 10.8.8.1

Setup Wizard > Default Gateway > Step 5

Would you use this port as your default gateway?

5. If there is more than one port on the ESXi server and you have assignhed two network
adapters to this FusionHub virtual machine, the LAN port configuration dialog will be
open. The default selection is Static.

Choose a connection method for LAN port

Static ©

DHCP

Disable
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e If Static is selected, the Setup Wizard will display Static IP Settings.

Enter the parameters of Static IP setting for LAN port

Static IP Settings

e If DHCP is selected, the Setup Wizard will display DHCP Settings.

Enter the parameters of DHCP setting for LAN port

DHCP Settings

i'dent D (Optional)

o If Disable is selected, the Setup Wizard will move to the next step.

Note: FusionHub virtual machines support a maximum number of two network adapters.

By default, Network adapter 1 is set as the WAN port, and Network adapter 2 is set
as the LAN port.

(%) FusionHub - Virtual Machine Properties L= )
o p— Vs Hace s
Memory Configuration
I Show All Devices Add... :
1011 GBa  Memory Size: 1= [ee ~]
Hardware | Summary | 512 GB
7 S Maximum recommended for this
E ::L"""” 1024 Mo mecall I guestOs: 1011G8.
s
& vid d vid 4 Maximum recommended for best
ideo car ideo car 128 GB H o performance: 8088 MB.
& VMCIdevice t‘%esmaed : 4 cald Defauit J for this
@, cojovodrivet jonHub... 4 guest OSE, :f GB.
© Hard disk1 WAN port 3268 e
& Floppy drive 1 T DETee 16 GaH < guest 0S: 64 MB.
@ Network adapter 1 Intranet
Network adapter2 VSub 8GBHq
4GB H
LAN port 268 H
1GBq
S12 MBS
256 MB
128 MBS
64 MBI
32MB
16 MB
8MB M
4mB U
| x| _cna |
A
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6. Click Next to define a Local ID before using PepVPN. The local ID is a text string that
identifies this local unit when establishing a VPN connection. Remote units can identify
this unit using the local ID, as well as by serial number. When creating a profile on a

remote unit, this unit’s local ID must be entered into the remote unit's Remote ID
field.

Please define a local ID before using the PepVPN.
Remote units can identify this unit by this *Local ID", in addition to the seral number.

PepVPN Local ID @
Local ID }

7. Click Next to choose the time zone of your country/region. Check Show all to
display all time zone options.

Setup Wirard > Timerone > Step 7

Choose time zone of your Country / Region,

Tima: Lome Settings

T Zorws

| (GMT+08:00) Baipng, Chonggng, Hong Kong, Urumgi 3
=] show al

8. Check to make sure all settings have been configured correctly, and then click Save
and Apply Settings to confirm.

Setup Wizard > Save and Apply Setting > Final Step

Confirm the configuration below. Click Back to modify the configuration settings in previous steps. Click
Save and Apply Settings when you are done.

Summary of Configuration

|static 1p
| 10.8.50.50
255.255.0.0

Ino

| FusionHubVM

'. (GMT+08:00) Beijing, Chonggqing, Hong Kong, Urumgqi

<<Back | Save and Apply Settings | Cancel |
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9. You will be redirected to the License Information dialog. The default selection for

Virtual Machine Model is VMware ESXi. The default License Information dialog
looks similar to the following:

Setup Wizard > License > License Activation

Enter bcense information

License Information

) vmware £5% [v]
®

(Registered trademarks are copynighted by ther respective owner)

If you are not using VMware ESXi, please select Other for the Virtual Machine \Model.
In that case, the license activation dialog will look similar to this:

Enter hcense information

License Information

e License Key is the FusionHub license key obtained from the InControl2
webpage. Please refer to FusionHub License Generation for details on creating
this license key.

¢ Virtual Machine Model is the virtual machine platform on which FusionHub
is implemented. If FusionHub is implemented on a VMware ESXi Server, please
select VMware ESXi. If it is implemented on a VMware Workstation or VMware
Player, please select Other.

o ESXi Server address is the ESXi server's hostname or IP address. Note:
this column is shown only when VMware ESXi is selected.

e Click Submit after filling the form.

10.When the license is successfully activated, you will see the following screen:
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Dashboard Setup Wizard Network System Status

Setup Wizard > License > License Activation

Setup has been completed successfully!

License has been applied, FusionHub will reboot in 10 seconds.

The information shown on the FusionHub console will change to the following:

Feplink Fi i B.1.8 build 1175

o configure network settings

If you have changed your computer’s IP to 169.254.x.x, please change the computer’s IP
settings so that they’re the same as your FusionHub network settings, and then connect to
FusionHub’s Web admin again.
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6. PepVPN with SpeedFusion Settings
This section will describe how to set up PepVPN with SpeedFusion.

6.1 Background

Peplink FusionHub securely connects one or more branch offices to your company's main
datacenter or to other branches. Data, voice, and video communications between these
locations are kept confidential across the public Internet.

FusionHub’s SpeedFusion Bandwidth Bonding feature, enabled by default, is specifically
designed for multi-WAN environments. FusionHub can bond all WAN bandwidth for routing
SpeedFusion traffic, and unless all of one site’s WAN connections are down, the Peplink
Balance can keep your VPN up and running.

When supporting multiple VPN connections, FusionHub can act as a central hub that
connects branch offices. For example, if Branch Office A and Branch Office B make VPN
connections to Headquarters C, both branch office LAN subnets and the subnets behind
them (e.g., static routes) will also be advertised to Headquarters C and the other
branches. In this example, Branch Office A will be able to access Branch Office B via
Headquarters C.

The local LAN subnet and subnets behind the LAN will be advertised to the VPN. All VPN
members (branch offices and the datacenter) will be able to route to local subnets.
Note that all LAN subnets and subnets behind them must be unique. Otherwise, VPN
members will not be able to access each other.

All data can be routed over the VPN using the 256-bit AES encryption standard.

In the following sections, three FusionHub application examples illustrate how to set up
your devices.
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6.2 Example One

Site A Remote Access to Central Server

MAXHD2 L%

~

WAN:10.10.x.x Jthy Data Center

\

FusionHub Video Server
vy

LAN:

Site B 172.16.31.x /
4 MAX BR1 £
FusionHub
g WAN [P:
ﬁ 10.8.50.50

WAN: 10.9.x.x

-

Figure 5.1 Remote Access to Central Server

To set up the scenario shown in Figure 5.1, we need to configure a MAX HD2 at Site A, a
MAX BR1 at Site B, and FusionHub (two network adapters are needed) at the Datacenter.
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In our case, FusionHub settings (refer to Configuration Using the Setup Wizard) are
as follows:

IP address: 10.8.50.50 (static IP)
Netmask: 255.255.0.0

Default gateway: 10.8.8.1

Local ID: FusionHubVM

%%

pep Dashboard Setup Wizard Network System Status

Interfaces
podioden :
= SpeedFusion™ Static E
QoS 10.8.50.50
\=iApplication’ 255.255.0.0 [~]
Misc. Settings
= Certificate dosies

Manager 10.8.8.1

Logoulu

Default
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MAX HD2 LTE configuration (Site A)
Suppose that the MAX HD2 in Figure 5.1 is configured with the following IP settings:

WAN 1 IP address: 10.10.13.49
WAN 2 IP address: 10.10.13.50
LAN IP address: 192.168.150.1

1. To configure, connect to the Web admin interface of the MAX HD2, and then navigate
to Advanced > SpeedFusion.

PEPWAVE Dashboard Network Advanced System WILC Status

® Port Forwarding
NAT Mappings
Qos

8 User Groups

« Bandwidth
Control

» Apphcation
Firewall
® Access Rules
® Waob Biockang
Misc. Settings
® High Avadabdty
. PPTP Server
. Service

£

¥ Recommended (Approx. 15 secs)
Fast (Approx. 6 secs)
Fastar (Approx. 2 secs)
Extrame (Under § sec)

Save

2. Next, click A | under PepVPN.

PepVIPN

Remote units can identify this unit by this "Local ID*, in
addition to the senal number.

OK Cancel
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4. Click New Profile under Profile to add a new profile.

Remote 1D

New Profile

L

5. On the dialog displayed next, fill the form as follows:
Name - Enter a name to represent this profile. In this case, we chose FusionHub.

Remote ID — Remote ID should be the same as FusionHub's Local ID. In our case, the
FusionHub local ID is FusionHubVM.

Click Preshared Key and create a pre-shared key, which is 12345678 in our example.

Remote IP addresses — Here, we've entered 10.8.50.50, the FusionHub IP address.

PepV N Frofile @

& & 256-bit AES B Off

By Remote ID only & Preshared Key X.509

el 10.8.50.50

i this Seld i5 ampty, this fedd on the remole unlt muest be fillesd

'-T.!' & pefault Custom

WAN Connection Priorily

1. WAN 1 : 1 (Highest) []
:z. WAN 2 : [1 (Highest) =]
: |1 (righest)  [=]
: |1 (Highest] [=]
s 1 (Highest) [=]
: |1 (Highest) [=]

6. After completing the form, click Save and then Apply Changes.

MAX BR1 configuration (Site B)
Assume the MAX BR1's IP settings are:

WAN IP address: 10.9.3.167
LAN IP address: 192.168.71.1
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1. To configure the MAX BR1, connect to the MAX BR1’s Web admin interface (in our
case, the Web admin interface address is http://192.168.71.1), and then navigate
to Advanced >PepVPN.

Apply Changes

M FMew Prolile
Al ton
Flrerwall [SCoardng ED Custoss publs]

& Recommended (Approo. 15 secs)
Fast [Appro. & S8cs)
Faster (Sppron. T $4C8)
Extrame [Under § sec)

S

/ ® MAX_BR1_1698

can dentify this unit

the senal numbaor
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4. Click New Profile under Profile to add a new profile.

Profile Remote ID Remote Address(es)

N Copnection Definad

New Profile

5. On the dialog displayed next, fill the form as follows:
Name - Enter a name to represent this profile. In this case, we chose FusionHub.

Remote ID — Remote ID should be the same as FusionHub's Local ID. In our case, the
FusionHub local ID is FusionHubVM.

Click Preshared Key and create a pre-shared key, which is 23456789 in our example.

Remote IP addresses — Here, we've entered 10.8.50.50, the FusionHub IP address.

PepVPN Profile

Hide Characters
€31 10.6.50.50

i this field is empty, this Said on the remote unit must be flled

@ Default Custom

Save Cancel

6. After completing the form, click Save and then Apply Changes.
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C. FusionHub configuration (Datacenter)
In our example, the IP address of the ESXi server is 10.8.9.24/16, and the FusionHub IP
address is 10.8.50.50/16.

1. To configure FusionHub, connect to the FusionHub Web admin interface
(http://10.8.50.50) again. Then, navigate to Network > SpeedFusion.

PepVPN with SpeedFusion™

@ InControl management enabled. Settings can now be configured on InControl.

New Profile

2. To add a new profile, click the New Profile button. On the dialog displayed next, fill
the form as follows:

Name - Enter a name to represent this profile. In this case, since we're adding the MAX
HD?2 to Site A, we chose Site A.

Remote ID — Remote ID should be the same as the MAX HD2's Local ID. In our case,
the MAX HD2’s local ID is MAX-HD?2.

Click Preshared Key, and then enter the same pre-shared key used with the MAX
HD2, 12345678 in our example.

PepVPN Profile

Active ]

SpeedFusion™ Supported

Encryption ® B 256-bit AES | BWOFF

Remote 1D )| Hax-HD2

Authentication By Remote ID only '® Preshared Key X.509

Pre-shared Key &) 12345678

| Hide Characters

NAT Mode J

Data Port * Default Custom

Save Cancel

3. After completing the form, click Save and then Apply Changes.
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4. Click New Profile again to add the MAX BR1 to Site B.

Name - Enter a name to represent this profile. In this case, since we're adding the MAX
BR1 to Site B, we chose Site B.

Remote ID — Remote ID should be the same as the MAX BR1's Local ID. In our case,
the local ID is MAX-BR1-169B.

Click Preshared Key and enter the same pre-shared key used with the MAX BR1,
23456789 in our example.

5. After completing the form, click Save and then Apply Changes.

PepVPN Profile

Name |S|'te B |

Active 4]

SpeedFusion™ Supported

Encryption ® & 255-bit AES ' TOFF

Remote ID @) MAX_BR1_1698 |

Authentication ) By Remote ID only '® Preshared Key "= X.509

Pre-shared Key 123456789 |

| Hide Characters

NAT Mode (]

Remote IP Address / Host @
Names (Optional)

If this field is empty, this field on the remote unit must be filled

@ '® pDefault Customl:l

Save Cancel

6. On the Dashboard, we see that PepVPN with SpeedFusion has been established for
Site A and B.

| 1P Address: 10.8.50.50

Status

& Established
B Established

Modal; Peplink Fusion Hub
Fmmwara: 6.1.0 build 1138
Uptimes: 0 day 1 hour 5 minubes
CPU Load: [ ] 0%
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7. In order to make a direct link between FusionHub and the video server shown on the
right-hand side of Figure 5.1, we need to add one more port (a network adapter) to

FusionHub’s virtual machine.

Adding a network adapter when using ESXi server
a. Login to the ESXi server again, and then power off the FusionHub virtual machine.
Next, click Edit virtual machine settings. On the FusionHub — Virtual
Machine Properties dialog, click Add to add another network adapter.

(@ FusionHub - Virtual Machine Properties | B
Hardware |opm | Resources | Virtual Machine Version: 8
Memory Configuration
™ Show Al Devices | Add... I l
101168 Memory Size: | 1= e v
Hardware | Summary ‘ 512 G814 )
W Memory 1024 M8 < "‘5'""05','2"'@" sended for tis
@ cus : Ay T
Maximum recommended for best
Video card Video card 128 GB <€ performance: 3033 M8,
& VMCldevice Restricted 64 GalHa Defauit recommended for this
G Hard disk i Virtual Disk < guest OS: 1G8.
@y CO/OVD drive1 [datastorel)FusionHub... 32 GBI+ Mo recommended foc this
B Network adapter 1 Intarnet 16 G8 4 guest OS: 64MB.
& Floppydrivel Client Device
8GE -
4GB H
2GBH
1GBq
S1Z2 M8
256 M8
128 M8
64 MEla
32 M6
16 MB
eMs
48
|
beo | o | cace |
4
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b. Select Ethernet Adapter, and then click Next.

(2 Add Hardware - — -
Device Type “
[ What sart of device o you wish 10 394 to your virtual machine?
Choose the type of device you wish to add.
Network connection
" eady to Complete y
F Thes device can be added to this Virtual Machine.
I
Hep I < Black I@ = [
| A
‘.

c. Select a network and adapter from the drop-down menus, and then click Next.

(3 4dd Harcware =] — oy
Ready to Complete
I Riestew the sedacted opbons and dhide Firesh to add $he hardware.
| ;au;:%c.a: Cpoeres:
etwork corpsiction
|  Readyto Complete Hardmre Type! Etratmaet Adapter
i Adscaer Ty E 000
Hetwork Connecton:  BA 1 LAN
| Conrsct ot power on: Vs
bl soack |[ owh | concm |
| — —
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d. Click Finish and then OK to save your settings.

(%) Add Hardware - - — ]

| Nebwork Type
i ‘What type of network do you want to add?
| Dievice T Adapber Type
| LEvice Type
| Metwork connection Type:  |E1000 |
Resdy to Complate
! Adapter cholce can affect both networking performance and migration compatibility.
| Consult the VvMware Knowled geBase for more information on choosing among the
Il network adapters supportedfor various guest operating systems andhosts.
Hetwork Connection
Hetwork label:
Port:  N/A
Device Status

¥ Connect at power on

_ o | <sack | [nemz | conce

1 £

Adding a network adapter when using VMware Workstation

a. Power off the FusionHub virtual machine and select Edit > Virtual Network
Editor

File View VM Tabs Help \
SR Cut Ctrl+X o | O ‘
I

I

Librar Copy Ctri+C
! Paste CtrtaV ) FusionHub ~
Q
1 © | Virtual Network Editor... nHub
1 Preferences... Ctrl+P
i Shared WMz this virtual me_chme

[GF Edit virtual machine settings

(g Upgrade this virtual machine

¥ Devices
% Memory 1GB
[ Processors 1

=i Herd Disk (IDE) 12M8B
¢, CD/DVD (IDE) Using file Fusion...

[ Floppy Using drive A:
¥ Network Adapter Bridged (Autom...
B Display 1 monitor
~ Virtual Machine Details

v Description State: Powered off

Configuration file: C:\U: dmin\D: A\Virtual

enter 3 description of this 3 . :
Machines\FusionHub\FusionHub.vmx
ion 8.0 virtual machine
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b. Under VMnet Information, select VMnet0 and check Bridged (connect VMs
directly to the external network). Select the appropriate network adapter from

the drop-down menu and click OK.

Virtual Network Edito

l Name Type External Connection Host Connection  DHCP Subnet Address
VMnet0  Bridged  Auto-bridging - - -
| VMnetl  Hostonly - Connected Enabled  152.168.2.0
VMnet3  NAT NAT Connected Enabled  192.168.159.0
VMnet Information
| B T B e T el
 Bridged to: ~ »] | Automatic Settings... |
‘ oy

- LTS .‘, -
NAT (shared pealtek PCTe GBE Family Controller

Host-only (dm USB-Ethemmet Adapter #2 =

Connect a host virtual adapter to this network

DHCP Settings...

Use local DHCP service to distribute IP address to VMs

[ ok J[ cance |[ ooy |[ Hep |
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c. Click Add Network.

[[Q vitual Network aitor W

Name Type External Connection Host Connection  DHCP Subnet Address
VMnet0 Bridged Realtek PCle GBE Famiy Co... - -

VMnet1 Host-only - Connected Enabled 192.168.2.0
VMnets NAT NAT Connected Enabled 192.168.159.0

VMnet Information
@) Bridged (connect VMs directly to the external network)

Bridged to: [MPCI:GEF&“ Controller } v] Aytomatic Settings...

) NAT (shared host's IP address with VMs) il
) Host-only (connect VMs internally in a private network)

Connect a host yirtual adapter to this network

Use local DHCP service to dstribute IP address to VMs DHCP Settings..

Restore Default [ ok || cacel || ooy |[ Hep |

d. On the Add a Virtual Network dialog, select a network to add from the drop-
down menu and click OK. In this example, we selected VMnet2.

> == 5
Add a Virtual Network E

2|

Select a network to add: |VMnet2 v]

ok |[ cancel |[ Hep |
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e. Select the VMnet2 network added in the previous step and check Bridged
(connect VMs directly to the external network). Click OK to apply changes.

Virtual Network Editor

| Name Type External Connection Host Connection  DHCP Subnet Address
VMnet0 Bridged Realtek PCle GBE Family Co... - - -
VMnet1 Host-only - Connected Enabled 192.168.2.0

L VWMnetR] NAT NAT Connected Fnahled 192 1A% 159.N
VMnet2 Bridged HighSpeed US8-Ethernet Ad... - -

[ Add Network... | [Rungveuemork]

VMnet Information
Wb'[meed l&fﬁﬁmt% 22 i v"’ Y 5-,_;207‘*5[: Settings...
NAT (shared host's IP address with VMs) NAT Settings..

Host-only (connect VMs internally in a private network)

Connect a host virtual adapter to this network

Use local DHCP service to distribute IP address to VMs DHCP Settings...

Restore Default [ ok | cancel |[ apy |[ Hep |
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f. Click FusionHub and select Edit virtual machine settings.

On the Virtual Machine

Settings dialog, select Network adapter. Check Custom: Specific virtual network and
select VMnet0 (Bridged). Then click Add to add another network adapter.

NAT: Used to share the host's IP address

Device S y ‘ Device status
5 Memory 168 | - Connected
[ Processors 1 V] Connect at power on
i Hord Disk (IDE) 12m8
& CO/DVD (IDE) Using file FusionHub-fie 1.iso Network connection
|| B4 Aanov | Jsinn drive A ) findged: Connected drectly to the physical network
; I T Wi Network Adapter Budged (Automatic) \ Repicate physical network connection state
) || =Displsy 1 mon¥tor

! ) Host-only: A orivate network shared with the host

(VMneto (Bridged)

7 LAN segment:

(LN Segments... | [ Advanced... |
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g. Select Network Adapter and click Next.

Add Hardware Wizard _— u

Hardware Type
What type of hardware do you want to install?

Hardware types: Explanation
i Hard Disk Add a network adapter, |
5y CD/OVD Drive
k4 Floppy Drive

&7 USB Controller

@) sound Card

B Parallel Port

Serial Port

(e Printer

Generic SCSI Device

<Back | [ Next> ]m
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h. Check Custom: Specific virtual network and select VMnet2 (Bridged) from

the drop-down menu. Click Finish to complete the network adapter addition
process.

.
Add Hardware Wizard - g

Network Adapter Type
What type of network adapter do you want to add?

Network connection
' Bridged: Connected directly to the physical network
Replicate physical network connection state
NAT: Used to share the host's IP address
| Host-only: A private network shared with the host
© Custom: Specific virtual network

(VMnet2 (Bridged) ] v

Device status
|| Connect at power on

[ <Bak | [ Fnsh ][ cancel |

Adding a network adapter when using VMware Player

The Virtual Network Editor is not available in VMware Player. If you want to test this
example with VMware Player, first add a virtual network editor to VMware Player. Then
follow the steps described in VMware Workstation to modify and add network adapters.
For details on adding a virtual network editor to VMware Player, refer to

http://www.eightforums.com/virtualization/5137-how-add-virtual-network-editor-vmware-
player-2.html#post275406

8. After adding one or more network adapters to the FusionHub virtual machine, select
FusionHub again. Click Power on the virtual machine, and then reconnect to the
FusionHub Web admin interface. Navigate to Network > LAN.

%%

pep Dashboard Setup Wizard Network System Status

Interfaces
= LAN
= WAN
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9. Once you've set up the LAN port, click Save and then Apply Changes. In this case,
the IP address of Port 2 is 172.16.31.100.

pep Dashboard Setup Wizard Network System Status

Interfaces
.‘fLAN Connection Settings
e |

= WAN

m SpeedFusion™
QoS
et

10.To set up the video server as shown in Figure 5.1, enter 172.16.31.x as its IP
address, and then set the default gateway so that it is the same as the IP address of
FusionHub's port (in this example, the video server’s default gateway address is

172.16.31.100). Finally, directly link the video server and FusionHub Port 2 with one
network cable.

Site A Remote Access to Central Server

WAN:10.10.x.x Data Center

FusionHub Video Server

£

172.16.31.x

MAX BR1
o FusionHub
ol WAN IP:
’ﬁ 10.8.50.50

WAN: 10.9.x.x

Figure 5.1 Remote access to central server
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6.3 Example Two

Office A Offices Interconnect and Internal Server Access

Head Quarter

/ Head Quarter \
LAN:

Firewall / 192.168.200.x

Router
Reees .
FusionHub
N :
10.8.x.x
|aem——
FusionHub
10.10.x.x WAN IP:

192.168.200.12

192.168.150.x

Internal Server

- /

In this example, the hosts located at Office A want to communicate with the host located
at Headquarters.

Figure 5.2 Offices interconnect
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Case one: Supposing that network access is always made from Office A to Headquarters,
setup your devices as follows:

MAX BR1 Settings
The settings for the MAX BR1 in Office A are the same as those in the first example,
except that the Remote IP Address/Host Names Optional item in the PepVPN profile

for FusionHub should be changed to the IP address of the firewall/router =1,

- MAX BR1 Setting: Advanced > PepVPN > Profile > FusionHub x| I
PepVPN Prodis @

@ FusionHub

Q)| ® &256-bit aes © BmoFF

'@ FugionHubvM

| ) By Remote ID only @ Preshared Key O X.509
(@) 23456789
] Hide Characters

Remote IP Address / Host (2) DTXEXE
Mames (Optional)

Type the IP Address of Firewall/Router

If this field is empty, this field on the remote unit must be flled
@ '® Default ) Custom

Save Cancel
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FusionHub Settings

The FusionHub settings are also the same as those used in the first example, except that
we need only one FusionHub port in this example. Therefore, if you have added a second
port during Example One, please complete the following steps to remove one port:

1. Power off the FusionHub
2. Remove the network adapter added in Example One
3. Power on the FusionHub

Next, connect to the FusionHub Web admin interface. Navigate to Network > WAN.
Check the box under SpeedFusion Peers Access Internal Network to enable it. To
save your changes, click OK and then Apply Changes.

X
[} .
pep Dashboard Setup Wizard System Status

Interfaces

pwan
a Speedragion™ ]

QoS

| static E]

192.168.200.12

= Application i
i 255.255.255.0 [+]

Misc. Settings

= Certificate | 192.168.1.1

Manager

togout |

SpeedFusion™ Peers Access Internal Network

_Default |
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Check NAT Mode in the PepVPN profile for FusionHub.

PepVPN Profile

© £ 256-bit AES ) BOFF

£ MAX_BR1_169B

| © By Remote ID only @ Preshared Key © X.509
(@)l 23456789 |

[C] Hide Characters

]

© pefault ) Custom

Save Cancel

Firewall/Router E settings
Forward UDP port 4500 to FusionHub (192.168.200.12, in our example). Then forward
TCP port 32015 to FusionHub (192.168.200.12, in our example).

Case two: Supposing that network access needs to be available on both sides:
Follow the same steps in case one except in Step 2 do not check NAT Mode in the
PepVPN profile for FusionHub.

Configuring the hosts located on the Headquarters LAN

In Figure 5.2, the host located on the Headquarters LAN is a PC named Internal Server.
In this example, you would need to add a static return route on this PC. For a PC running
Windows, the command to add a static route is route add -p <MAX BR1 LAN's network>
<MAX BR1's netmask> <FusionHub's local IP address>.

Example: > route add -p 192.168.71.0 mask 255.255.255.0 192.168.200.12 (assuming
FusionHub's local IP is 192.168.200.12). Here, -p makes the added route persistent across
system reboots. This option is not supported in Windows 95.

NOTE: If you use a Peplink product as your firewall/router in this example, you will need
to disable all PepVPN with SpeedFusion profiles.
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6.4 Example Three

CountryA Public VPN Access /
[ \ Location Dependent Content Access

MAXBR1

CountryC

CountryB

P
(" maxmHp2 ) wg\
* - S \ FusionHub

“ WAN |P:
KlO.lO.x.x 3 Contentonly available 10.8.50.50
to Country C
=

S v

Figure 5.3 Public VPN Access / Location Dependent Content Access

In this case, the settings of the MAX BR1 in Country A and the MAX HD2 in Country B are
similar to those settings in the first example. However, the following changes must be

made:
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MAX BR1 Settings -
1. Navigate to Advanced > PepVPN, and then click under Outbound Policy.

PE PWAVE Dashboard Netwd System Status Apply Changes

“~dvanced
2 | wi-Fi Settings N
mpepen 1 PepVPN %
R ——

s [Psec VPN
= Port Forwarding ile Remote ID Remote Address(es)

. FusionHub —] FusionHubVM

NAT Mappings

QoS New Profile

X

= Application 3
Flrewall ] (According to custom rules) # l
Misc. Settings A
= Service

Forwarding Source
- gemtc': : {Auto)

355
e Add Rule
Logout

N
@ MAX_BR1_1698
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2. On the dialog displayed next, check the box under Send All Traffic To. Select
FusionHub from the drop-down menu. Here, FusionHub is the profile name. Next,
set DNS server to the same address used by FusionHub's DNS server, which is
10.8.8.1 in this example. To save your changes, click OK and then Apply Changes.

Send Al Traffic
Send All Traffic To

4| | FussonHub 3
DMNS Server
10,8.8.1

(oK | [ Cancel |

MAX HD2 Settings _ _
1. Navigate to Advanced > SpeedFusion, and then click under Send All Traffic To.

el i i —m

Advanced

s Wi-Fi Settings

- ['Bsec Vm
= Outbound Policy

= Certificate
Manager

= Port Forwarding
NAT Mappings
QoS

BUser Grouns

PepVPN with SpeedFusion™ %

Profile Remote ID

E_':_T'.H-‘ - | FusionHubVM

Remote Address(es)

New Profile

,;‘ {No PepVPN profile selected)

2. On the dialog displayed next, check the box under Send All Traffic To. Select
FusionHub from the drop-down menu. Here, FusionHub is the profile name. Next,
set DNS Server to the same address used by FusionHub's DNS server, which is

10.8.8.1 in this example. To save your changes, click OK and then Apply Changes.

Send all Traffic

Send All Traffic To

|| FusionHub E
DNS Server
10.8.8.1

[ok | [ cancel |
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The FusionHub settings are also similar to those settings in the first example, except that
we need only one FusionHub port in this example. Enabling SpeedFusion Peers Access
Internal Network is not needed here, so we've left the box unchecked.

| SpeedFusion™ Peers Acce : 20w
Enable @! 1 Do not check this box-

N y
~—
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